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Foreword 

DWAT is a software to analyze water cycle for a watershed or water management unit with 
runoff, evapotranspiration, water use and water supply in aspect of space and time. DWAT uses 
a distributed conceptual scheme for water cycle analysis and can be used with or without 
observed data. As the system is linked to an open GIS tool, physical input parameters can be 
searched and optimized conveniently. DWAT has been developed since 2008 as a part of WMO 
(World Meteorological Organization) RA (Regional Association) Ⅱ WGHS (Working Group on 
Hydrological Services) activities, and it has been supported by the Han River Flood Control 
Office, Ministry of Land Infrastructure and Transport, Republic of Korea. 
 
The global analysis of a hydrologic-hydraulic network is essential in numerous decision-making 
situations such as the management or planning of water resources. DWAT makes such 
analyses accessible to a broad public through its user-friendly interface and its valuable 
possibilities.  
 
DWAT contains sub-algorithms such as evapotranspiration, infiltration, watershed runoff, 
groundwater movement and channel routing. The model is under verification through 
applications to various rural and forest catchments and new urban development regions in 
Korea. The model reliability will be strongly enhanced through the further model applications to 
global area. 
 
The DWAT was developed in a “node-link type” that enables objective considerations of runoff 
characteristics resulting from different geomorphological factors by dividing ranges into sub-
catchments judged to be hydrologically homogenous. The user interface of the model was 
developed for easy access and operation of the model and it will help how to use the model to 
effectively simulate and analyze many scenarios simultaneously.  
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The purpose of this user guide gives instruction on how to use the DWAT. When using the 
program, please check the content of this user guide. 
 
Copyright ⓒ 2016 KICT & HRFCO 
The copyright of the DWAT is reserved by KICT & HRFCO.  
Any commercial use or unauthorized reproduction of the program and the user manual are 
strictly prohibited. 
KICT & HRFCO accept no responsibility and exclude all liability whatever in respect of the 
program and any person’s use or reliance on any information of this publication. 
For any further information on this program including technical issues and questions regarding 
to the use of the program, please contact researchers and development team. 
 

October, 2016 
 
 
 
 
 
 
 
 
 
 
■ Research/Development team 
Hydro Science and Engineering Research Institute, Korea Institute of Civil Engineering and 
Building Technology, 283 Goyangdae-ro, Ilsanseo-gu, Goyang-si, Gyeonggi-do, 411-712, 
Republic of Korea. 
- Team leader: Sung, KIM(skim@kict.re.kr), Ph.D, Senior Research Fellow 
- Researchers: Cheolhee, JANG(chjang@kict.re.kr), Hyeonjun, KIM(hjkim@kict.re.kr) 
TEL.: 82-31- 910-0745 
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Chapter 1: Introduction 
 
This user guide provides instruction on how to use DWAT and assists water resources 
engineers and researchers to easily understand the program and to increase the ability to apply 
the program to fields.  
This chapter includes introduction to program installation and its interface. In addition, all the 
processes to create, extract and correct input data are explained in detail and the methods to 
execute the model and analyze various figures and graphs are explained.  
However, the configurations of the model described in this user guide are those for the current 
version and they may be changed with further development. Characteristics of DWAT are 
summarized as follows: 

‣ Physical parameter-based link-node type model 
‣ Separate runoff simulations for pervious and impervious zones 
‣ Analysis of infiltration, evaporation, groundwater flows relative to soil layers and  

groundwater aquifers and simulations of channel routing 
‣ Simple, practical and easily accessible 
‣ Guaranteed satisfactory results with minimal data and efforts 

 ‣ Easy user convenience system (GUI) 
‣ Provision of results through diverse tables and figures 
 

1.1 System Requirements 

In order to use the DWAT program, at least 100Mb are required as the minimum available disk space. 

The minimum requirements for a PC system are summarized in the following table.  
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1.2 Installation procedure 

 

You install the DWAT by double-clicking on the DWATSetup.msi file in the installation directory. 

 

(교체) 

When the ‘DWAT Setup screen’ appears, click Next. 

System Minimum Recommended 

Operation systems 
Windows 98, Windows ME, Windows XP, Windows 2000, 

Windows Vista, Windows 7,  Windows 8,  Windows 10 

Memory 512MB 1GB 

CPU P-4, 1.5Hz processor 
P-4, 3.0Hz processor 
Core2 2.0 processor 

Hard disk capacity 100Mb extra space 500Mb extra space 
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(교체) 

The DWAT install defaults to installing the program in C:\Program Files\DWAT and users can create 

their own directory structure. Once you’ve designated the directory to which the program will be installed, 

click Next. 

 

(교체) 

In the ‘installation confirmation screen’, click Next. 
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(교체) 

The ‘Program installation screen’ will appear. If you click the cancel button, the program installation will 

not be completed. Please wait until the ‘Installation completion screen’ appears. 

 

(교체) 

When the ‘Installation completion screen’ has appeared, click Finish.  

The DWAT program has been successfully installed. 

 

You may check the installation in the ‘Program Start Menu’.  

Windows start menu > program > DWAT > DWAT 
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Chapter 2: Model Interface 
 

The interface of the model has been developed so that it can be easily applied and managed by users and 

so that various scenarios can be easily applied. The user interface has been designed so that all 

input/output data are linked with Microsoft Excel. All data sets are easily managed in each project. The 

environment used in developing the user convenience system (Graphic User Interface, GUI) is Microsoft 

Visual Studio and the system was developed for Windows.  

Figure 2.2-1 shows the basic configuration screen of the DWAT. The main screen of the DWAT is 

primarily divided into the Main Interface, Parameters and Node. The tools are used in analysis and 

include the Main Menu and Toolbar, Node, etc. The Parameters window indicates the attributes of nodes 

and the variables of selected nodes. 
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<Figure 2.2-1> Basic configuration screen of the CAT 
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2.1 Main Menu 

The DWAT has six main menu items and they are shown in Figure 2.2-2. The main menu provides 

overall operation functions, including project file management, model executions and input/output result 

checking.

 

<Figure 2.2-2> DWAT main menu 
 

The functions of each menu are reviewed in the following sections. 
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2.1.1 File 

New Project: This is a menu to create new projects. This menu clears all data in memory and interface 

fields and opens an empty project.  

Open Project: This is a menu to display the standard file open dialog. It allows users to open existing 

projects stored in the certain directory and is mainly used to revise existing data in the project. The 

extension of the project files of the DWAT is *.dpr and only project files (*.dpr) can be opened. 

 

(교체) 

 

Save: It allows you to save the current .cpr file (including all screens, attribute information and data of 

the open project).  

Save as: It allows users to save the current project under another name. 

Save reslult: It allows users to save simulation result of the current project under another name. 

Background: Background images (*.bmp or *.jpg) can be imported. This may be useful for configuring 

each source node and link on the background (e.g. the watershed boundaries and rivers).  
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(교체) 

 

Create Series: This menu creates time series (e.g. rainfall, meteorological data and observed discharges) 

into input data files (*.dat) in the DWAT.  

(교체) 
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2.1.2 Edit 

Edit menu has various functions. These are briefly described below. 

 

Undo: a function to undo after editing 

Cut: a function to remove attribute tables, links and nodes 

Copy: a function to reproduce attribute tables, links and nodes 

Paste: a function to paste attribute tables, links and nodes 

Delete: a function to delete attribute tables, links and nodes 

 

2.1.3 View 

View menu has various functions. These are briefly described below. 

 

Toolbar: a function to show or hide the tool bar on the bottom of the main menu 

 

 

Status bar: a function to show or hide the display window on the bottom of the CAT program window 

 

 

Pan: a function to pan the entire configuration screen 

Zoom in: expanding function (interlocked with mouse scrolls) 

Zoom out: reducing function (interlocked with mouse scrolls) 

Series: functions to display the time series input data recreated in the DWAT; check, edit and save data 

files from model outputs; export the files as text (*.txt) files (since all files created in the DWAT are 
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stored in the form of data files, *.dat (binary type format), this is a function to facilitate users' checking.). 

(교체) 

 

2.1.4 GIS Preprocessor 

Hydrologic models like DWAT require land use and soil data to determine the area and the hydrologic 
parameters of each land-soil category simulated within each sub-watershed. 
The physical parameters of the system can be searched and optimized conveniently using GIS 
Preprocessor menu. This tool allows users to load land use and soil themes into the current project and 
determine the land use/soil class combinations and distributions for the delineated watershed and each 
respective sub-watershed. 
Watershed delineation is one of the most commonly performed activities in hydrologic analyses. Digital 
elevation models (DEMs) provide good terrain representation from which watersheds can be derived 
automatically using GIS technology.  
 
The complete process of watershed delineation and input parameters using GIS Preprocessor involves a 
sequence of steps 

1. It is important to use a DEM with no depressions or sinks, so we first have to “fill” the DEM. 
• To create an accurate representation of flow direction and, therefore, accumulated flow, it is 
best to use a dataset that is free of sinks. A digital elevation model (DEM) that has been 
processed to remove all sinks is called a depressionless DEM. The identification and removal 
of sinks, when creating a depressionless DEM, is an iterative process. When a sink is filled, 
the boundaries of the filled area may create new sinks that need to be filled. 
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2. Determining the slope direction at each pixel, i.e. the “aspect” of the terrain. 
3. Determining the “flow accumulation”, that is, the number of up gradient pixels that slope 

toward each point in the DEM grid. 
4. Calculation of preliminary stream network raster using a flow accumulation. 
5. Add a point that represents the outlet of watershed. You need to add and load a “shape file” 

that has the outlet for the watershed. 
6. Determining watershed area using channel threshold value. 

• Set the channel formation threshold value to something like 100 or 1000 or 5000 depending 
on the size of your watershed and goals of your analysis. There is no standard threshold value. 

7. Overlay Soil map. 
• In this model, the concept of surface soil indicates the depth (range) where pores exist to 
temporarily store intermediate runoff. In the DWAT, infiltration and evapotranspiration into/from 
soil are analyzed based on the physical characteristics of soil, and thus surface soil parameters 
should be established. The physical characteristics of soil (including soil depth, saturated 
hydraulic conductivity, horizontal hydraulic conductivity, saturated moisture contents, residual 
moisture contents and Mualem's n) are used in this model. The information on the surface soil 
depths and parameters is used after being classified by soil texture based on the 1:25,000 precise 
soil map. 

8. Overlay Land use map 
• Input data for land use conditions includes ground surface slopes, impervious area ratios and 
depression storage. The information on topological parameters is based on land use map from the 
National Geographic Information System (NGIS). 
 

First go to Main Menu and select GIS Preprocessor. 
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DEM: A browser will be displayed allowing the user to select the DEM grid (Raster file: hdr.adf). 
 
This file format (*.adf) is the internal binary format for Arc/GIS Grid, and takes the form of a coverage 
level directory in an Arc/GIS database. To open the coverage select the coverage directory, or hdr.adf 
from within it. 
 

 

 

Click Open to proceed. When this step is complete, DEM and flow accumulation theme is added to the 

GIS Preprocessor view.  
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OUTLET: It allows users to add an outlet point. 
 
Once you have zoomed in, go to the Select outlet browser. Make sure to select which folder to use 
whichever one has the newly created shape file for the outlet point. Click “Add point”, directly user 
placed from add point using left-clicking on a stream pixel. 
If you are off the stream channel by so much as one pixel you will not delineate the correct drainage 
area. Your outlet point must be in a flow channel pixel. 
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Click OK to proceed. You are ready to delineate watershed area. 

 

BASIN: It allows you to delineate watershed area using channel threshold value. 

 
 

Click OK to proceed. You have delineated a watershed. 
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SOIL: It allows you to overlay soil type theme to the watershed boundaries.  

DWAT require land use and soil data to determine the area and the hydrologic parameters of each land-

soil category simulated within each sub-watershed. If the soil and land use is defined in the same 

projection as the DEM, select shape file (*.shp) in file browser. If soil map is not projected as the DEM, 

This will stop map processing. 

When this step is complete, a dialog box will pop up listing database files from which soil type can be 

selected. User need to define DWAT soil type associated with soil type theme categories. Select the 

attribute field containing the codes/category values to be reclassified: SO_TYPE. 

 
 

Click OK to proceed. 
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LANDUSE: It allows you to overlay land use theme to the watershed boundaries.  

Select land use theme (*.shp).  

 
 

When this step is complete, a dialog box will pop up listing database files from which soil type can be 

selected. Select the attribute field containing the codes/category values to be reclassified: UCB. 
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Click OK to proceed. Land use theme is added to the watershed boundaries. 

 
 

RUN: It allows you to determine the area and the hydrologic parameters of each land-soil category 

simulated within each sub-watershed. When this step is complete, land use attributes box will appear 

stating that the land use theme has been processed to the watershed boundaries. The attributes box also 

remind the user to edit a look-up table or manually define the land use classes for the theme. 
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You can manually assign a land use NAME and TYPE.  

- To manually assign land use NAME, double-click in the NAME fields. 

 
- To manually assign land use TYPE (Pervious, Impervious and Plant), highlight the desired 

database item by clicking on it. 

 
 

Click OK to proceed. This will return you to the definition of soil attributes box. 
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The attributes box also remind the user to edit a look-up table or manually define the soil classes for the 

theme. 

You can manually assign a soil NAME, TYPE and Properties.  

- To manually assign soil NAME, double-click in the NAME fields. 

 
- To manually assign soil TYPE, highlight the desired database item by clicking on it. 

 
- To manually assign soil Properties, double-click in each fields. 
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Once the joining attribute codes have been assigned to all map categories, the file browser will be 

appeared. It allows the current file to save in text file format (attribute information and data of the 

watershed).  

 
 

Click SAVE to proceed. Hydrologic model is created. 

 
 

Click OK to proceed. When you close the GIS Preprocessor window, Delineated watershed is appear. 
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2.1.5 Model  

Table: The results for hydrologic component at each source node can be displayed at table 
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Chart: Graphs of the simulation results after running the model will appear on screen. 

 
 

Model Setup: It allows users to set up environments for running the model (e.g. simulation time and 

period) 

 
 

Run : It allows users to execute model simulation  

 



31 

 

 

 

2.1.6 Help 

Manual: It is a view menu for the DWAT user manual 

Support: It allows users to link to the DWAT’s website 

About CAT: It is a menu to identify the copyright and version information of the DWAT 

 

2.2 Icon 

The user interface of the DWAT basically includes 10 icons. There are: Three basic nodes (i.e. Catchment, 

Reservoir, Wetland); and four functions for catchment configurations (i.e. Links, Junctions, Recycle, 

Import and Outlets to connect between nodes). In addition, Select and Climate icons are included to check 

attributes.  

 

 

 

2.3 Property View 

The Property View displays the attribute information of each node, link and junction. That is, an attribute 

information screen automatically appears on the left when a node, link or junction is individually selected 

on the main screen. Information on parameter values can be identified and corrected. 

  



32 

 

 

 

 

 

Chapter 3: Model Input Data 
 

The DWAT requires various input data to reflect watershed characteristics, such as topology, geological 

features, hydrologic and hydraulic features, artificial systems for water use and drainage, in the analysis 

of water cycle.  

In the analysis, the DWAT uses physical parameters based on physiographic factors, soil and groundwater 

as shown in Table 3.1. Physical parameter values can be established using land use data, soil diagrams 

and river data, etc. Table 3.1 ~ Table 3.3 contain a list of input data at source nodes (i.e. urban, forest, 

paddy and water cycle improving facilities) and links. In this chapter, the processes to create, extract and 

process these input data are explained in detail.  
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<Table 3.1> Model parameter (Catchment nodes) 

Division Input variable Description of variable Unit 
Subject 

watershed Area Area ㎢ 

Meteorological 

condition 

Latitude, Elevation, Height 
the location, elevation and height of the 

observatory m 

Climate data rainfall, wind velocity, sunshine hours, 

lowest/highest temperatures, relative humidity 
- 

Ground surface 

condition 

Slope catchment average slope - 
Aratio_imp impervious area ratio % 
Aratio_per pervious area ratio % 

Aratio_per_plant Vegetation area ration in pervious zone % 
DepC_imp depression capacity in impervious zone mm 
DepC_per depression capacity in pervious zone mm 

Surface soil 

theta_per current soil moisture content - 
soil_th_per soil thickness m 

s_per Saturated soil moisture content - 
r_per residual soil moisture content - 

FC_per SMC at field capacity - 
W_per SMC at wilting point - 
ks_per saturated hydraulic conductivity mm/s 
ksi_per Saturated horizontal hydraulic conductivity mm/s 
Mualem Index for Mualem Eq. - 

PSI wetting front soil suction head mm 

fo 
maximum or initial value of infiltration capacity 

into soil 
mm/hr 

fc 
maximum or ultimate value of infiltration capacity 

into soil 
mm/hr 

k decay coefficient hr-1 

River 

rivE riverbed elevation m 
Area_riv area of riverbed ㎢ 

riv_th thickness of riverbed m 
ku_riv riverbed material permeability coefficient mm/s 

Groundwater 

aquifer 

gwE current groundwater level m 
aqf_S storage coefficient of aquifer - 

aqf_Top top elevation of aquifer m 
aqf_Bot bottom elevation of aquifer m 
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aquifer slope average slope of aquifer - 
node length average node length m 
conj. length conjugated length between nodes m 

Kgw saturated hydraulic conductivity of aquifer mm/s 
GW_pump_rate groundwater pumping rate ㎥/day 

leakage_rate leakage rate of water supply networks - 

 

<Table 3.2> Model parameters (Other node) 

Division Input variable Description of variable Unit 

Reservoir 
(online/offline) 

vol_init initial storage m3 
vol_eff effective storage m3 

intake_vol intake volume m3/day 
Kgw saturated hydraulic conductivity of aquifer mm/s 

spill_ht Height of spillway m 
spill_length Length of spillway m 
spill_coef overflow coefficient of spillway - 
pipe_ht Height of outlet pipe m 

pipe_area Area of outlet pipe m2 
pipe_coef runoff coefficient of outlet pipe 

 
offline_max Maximum inflow into offline pond m3/sec 
offline_ratio Control ratio for offline inflow - 
offline_out downstream outflow from offline pond m3/sec 

H-V-A stage-storage-area relationship m-m3-m2 

Wetland 

vol_init initial storage m3 
vol_max maximum storage m3 

flood_bypass High flow bypass during flood m3/sec 
Kgw saturated hydraulic conductivity of aquifer mm/s 

pipe_ht Height of outlet pipe m 
pipe_area Area of outlet pipe m2 
pipe_coef runoff coefficient of outlet pipe - 

H-V-A stage-storage-area relationship m-m3-m2 

Recycle 
rec_intake Total intake volume m3/day 
rec_cond Restriction for intake rate according to streamflow % 
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external water 

supply 
import_water Constant volume or time series data of imported 

from outside 
m3/day 

Leakage leakage rate % 

 

<Table 3.3> Model parameter (link, channel routing) 

Division Input variable Description of variable Unit 

Channel 

routing 

Muskingum 
DT time step for calculation unit time 
X routing factor (0.0 ～ 0.5) - 
K wave travel time hr 

Muskingum Cunge 

Channel length length of channel m 
Channel slope bed slope of channel - 

Manning N Manning roughness coefficient - 
Top width top width of channel m 

   

Kinematic wave 

Manning N Manning roughness coefficient - 
Channel slope bed slope of channel - 
Channel length length of channel m 
Bottom width bottom width of channel m 

Top width top width of channel m 

Channel depth channel depth m 
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3.1 Subject Catchment 

The range of water cycle assessment primarily consists of watershed systems, including stream network. 

In the stage of composing a watershed system, catchment information is required and information on 

water level stations is needed to compare simulation results to observed data. The user can import images 

of watershed systems including catchment information as the background. It allows users to configure 

links and source nodes easily.  

3.1.1 Background Image 

(교체) 

Load: It allows users to insert background images 

(교체) 
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Adjust: It allows users to adjust the location and size of imported background images 

Delete: It allows users to delete background images 

When a background image has been loaded, a screen as shown below is created. 

(교체) 

 

3.2 Climate  

The DWAT requires the meteorological time series such as the highest/lowest temperatures, wind 

velocities, sunshine hours, humidity, etc. the model was designed to enable loading not only text files but 

also Microsoft Excel files. When inputting meteorological data in Excel or text files, the model has also 

been designed to enable users to freely load time series data defined by the users without standardized file 

formats. It facilitates the easy usage and management of the program. In addition, the user can not only 

choose weather stations but also can allocate weighted values from the Thissen networks at each node. 

The location of each weather station, the height from the ground of each observing device and the 

latitudes should also be collected. They are necessary to calculate potential evapotranspiration by the 

Penman-Monteith method.  
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3.2.1 Climate Data Import 

(교체) 

 

Create series: It allows users to create Excel (*.xls), text (*.txt), and DBF (*.dbf) formats of 

meteorological data into the DWAT input data file (*.dat) format. The following window will pop up. 

 (교체) 

 

Time step: time step for climate data (min, hour, day month, year) 

Period: time of start and finish 

Field: specify the type of field for input (to calculate the evapotranspiration, temperature, wind, humidity 
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and sunshine hours selected. After select the field name and click the Add), the user can prepare his/her 

own data with format of *.xls or *.txt and Copy & Paste can be carried on.  

(교체) 

(교체) 

: Click and enter the saving directory and file name. 
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: Enter the file description. 

Save: The file will be saved as DWAT time series input data by pressing the ‘Save’ button. When the 

saving has been completed, press the ‘Confirm’ button. 

 (교체) 

 

3.2.2 Climate Data Checking 

To check whether data have been properly saved or not, the following process should be performed:  

(교체) 

Series: It allows users to display all data files created in the DWAT in the screen. View > Series gives 

the following window.  Pressing this button to display meteorological data previously saved, and then  

pressing this button  to load the time series data in the spread sheet of the window as shown in 
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the following figure. 

 (교체) 

 

The following figure appears on the upper part of the ‘Series View’ window. It shows information of the 

data file: the time interval (one hour), the number of data rows (17,544) and the data start time 

(2000/01/01 00:00).  

 

  

 

This is a function to modify the time interval for input data. Once it has been selected, the current time 

interval appears. The process is: change the time interval in the ‘NEW’ tab; select whether to show the 

sum, average, maximum or minimum in the ‘Method’ tab; and then press ‘OK’.  The changed time 

interval will be displayed. 
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(교체) 

: If meteorological data imported by the DWAT have been checked, these data may be 

exported in text file format (*.txt). These text format data may be opened and checked in general text 

editors.  

 

(교체) 

 

In addition, meteorological data imported into the ‘Series View’ may be revised and the revised 

data may be saved under another name.  

 

3.2.3 Climate Node Entry 

After completing the processes of setting the catchment system and importing meteorological data, 

the user will reach the stage to enter meteorological nodes. As mentioned earlier, the DWAT is a node-

link model and the user can select icons (e.g. link, source and junction) with a mouse to easily configure 
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catchment information. A climate node will be created by clicking the left mouse button on the 

appropriate position in the ‘Main Interface’ after selecting the Weather icon  in the meau. The same 

process is required to configure multiple weather stations. 

 

 

 

When meteorological data is used in the DWAT, the user not only can choose climate stations having 

meteorological data but also may allocate weighted values from the Thissen network at each node. 

Although meteorological data had to be separately established to use the Thissen network, data were fixed 

as meteorological data to be used for one node in existing urban water cycle models. In the DWAT, 

weighted values as shown in the following Figure were configured for usage.[H1] 

To back to meteorological node inputs, the user should enter weather station information and conditions 

for simulations. After left-clicking on a meteorological node, the following window will appear on 

‘Property View’. 
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Property: This is a menu to import meteorological data and enter weather station information. .  

 

 

Climate station names may be modified in the ‘Name’ column and a brief description is to be entered into 

the ‘Descript’ column. After that, press a button under ‘Climate’ to import meteorological data. 
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Calculate: By selecting ‘True’, parameters to calculate Penpan-Monteith potential evapotranspiration can 

be brought from meteorological data. If ‘false’ is selected, the program will use the potential 

evapotranspiration entered by users. 

Latitude, Elevation and Height: This a dialog box to enter the location of the climate station (latitude, 

elevation and height). This function is used when the ‘True’ option has been selected.  

When all information of the meteorological nodes have been defined, press the ‘OK’ button. 

Table: This is a menu to identify rainfall and calculated evapotranspiration in a table. This function may 

be used once the model has been executed. That is, this menu is used to view results after running the 

model. Meteorological data can be identified at the View > Series menu. 

 

 

 

Chart: This is a menu to view graphs from the model runs. This function is provided in not only a 

meteorological node but also all links, nodes and junctions. No matter which of them is selected, an 

identical window will appear (i.e. no matter which source node, link or junction is selected, graphs at all 

points can be identified). This menu will be explained in the 'Result Analysis' chapter in detail.  
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Following graph shows the result of Potential evapotranspiration (ETp) and actual evapotranspiration at 

source node.  

 

 

DWAT can use the rainfall gauges in network. The Thiessen weight coefficient can be specified to each 

source node. Also it can specify different stations for climate data and stations for rainfall data 

considering the climate measuring stations are rare compare to rainfall measurement. The maximum 

gauging stations to apply climate and rainfall are five. .  
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ET method: It allows users to select actual evapotranspiration calculation methods 

 

 

Monthly Coefficient: A method to calculate actual evapotranspiration by multiplying the potential 

evapotranspiration with monthly coefficients.  

Leaf Area Index: A method to calculate actual evapotranspiration considering monthly leaf area 

indexes (LAI, Leaf Area Index) and soil moisture contents (the same method used in the SWAT, Soil and 

Water Assessment Tool) 
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FAO 56: The actual evapotranspiration is calculated by the Penman-Monteith method in FAO56 using 

climate data (Max. & Min. air temperature, sunshine hours, humidity and wind speed). 

 

 

The above figure shows how to enter monthly coefficients. Monthly evapotranspiration correction 

coefficients and monthly leaf area indexes (LAI) are entered in the monthly method and the AETSWAT, 

respectively. The types of vegetation used in the model are divided into four groups: forests, grasslands, 

urban trees and crops (Jia, Y., 2002). The leaf area indexes are values from a previous study (A study on 

the development of watershed diagnosis methods for establishing healthy water cycle systems, 2005). The 

following figure shows the leaf area indexes (LAI) applied to the model. 
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3.3 Ground Surface 
Once entries of the meteorological nodes have been completed, information on the source nodes, links 

and junctions configured about sub-catchments is to be entered one by one. Input data for ground surface 

conditions includes ground surface slopes, impervious area ratios and depression storage as shown in 

Table 3.1. In general, depression storage in impervious zones is undertsood as 2mm. Examples of 

impervious area ratios by land use are shown in the Table 3.4.  

<Table 3.4> Classification of land cover 

* Ratio of impervious area (Guideline for river planning, KWRA, 2009) 

 

Classification Class 1 Class 2 Ratio Impervious area * (%) 

1 

Urban 

residential 65 

2 industrial 72 

3 commercial 85 

4 recreation 50 

5 road 100 

6 public 60 

7 

Agriculture 

paddy - 

8 upland - 

9 Green house - 

10 orchid - 

11 Etc. - 

12 

Forest 

decidious - 

13 coniferous - 

14 mixed - 

15 

Grass 

natural - 

16 golf course - 

17 Etc. - 

18 
Wetland 

inland - 

19 coastal - 

20 
Bare soil 

mines - 

21 etc - 

22 
Water 

inland - 

23 sea - 
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In this chapter, entry processes for the basic ground surface condition of the Catchment node will be 

explained in detail.  

 

3.3.1 Catchment Node Entry 

Catchment node will be located by placing each of the Catchment node icons at an appropriate 

position on the Main Interface and left-clicking the mouse after selecting each node icon. 

 

 

 

3.3.2 Parameter Entry 

In the following Figure, the ‘Property View’ will show the information on the catchment node.  

The ‘Property View’ is used to enter or revise all catchment node data (ground surface, soil, groundwater 

aquifer, etc). Basic ground surface conditions are to be entered under the node.  
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Name: This indicates source node (sub-catchment) names. 

Descript: Information of a source node (sub-catchment) may be entered. 

Area: source node (sub-catchment) area. 

Slope: watersheds' average slope. 

Impervious: impervious area ratio. 

Pervious: pervious area ratio. 

Plant_ratio: vegetation area ratio in pervious zone (This parameter is an evapotranspiration-related 

variable that is divided into four types, including forests, grasslands, urban trees and crops, and the range 

of the variable and these values are shown in the following figure (Jia, Y., 2002)).  
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DepC_imp: depression capacity in impervious zone (generally 2 mm) 

DepC_per: depression capacity in pervious zone 

3.4 Soil 

In this model, the concept of surface soil indicates the depth (range) where pores exist to temporarily store  

intermediate runoff. In the DWAT, infiltration and evapotranspiration into/from soil are analyzed based 

on the physical characteristics of soil, and thus surface soil parameters should be established. The 

physical characteristics of soil (including soil depth, saturated hydraulic conductivity, horizontal 

hydraulic conductivity, saturated moisture contents, residual moisture contents and Mualem's n) are used. 

The information on the surface soil depths and parameters is used after being classified by soil texture 

based on the 1:25,000 precise soil map. The following table is utilized based on the study (A study on the 

development of watershed diagnosis methods for establishing healthy water cycle systems, 2005). In 

Table 3.5, the horizontal hydraulic conductivity is determined by giving 10 times the values of the 

saturated hydraulic conductivity. 

 

<Table 3.5> Surface soil input parameters by soil texture 

Soil texture 

saturated 
moisture 

content ratio 
s_per 

residual 
moisture 

content ratio 
r_per 

SMC,   
field  capacity  

FC_per 

SMC,  
wilting point 

W_per 

saturated 
hydraulic 

conductivity 
Ks_per 
(mm/s) 

Horizontal 
hydraulic 

conductivity  
Ksi_per 
(mm/s) 

Mualem's  
n 

Sand 0.437 0.020 0.091 0.033 6.5E-02 6.5E-01 3.37 
Loamy Sand 0.437 0.035 0.125 0.055 1.7E-02 1.7E-01 3.64 
Sandy Loam 0.453 0.041 0.207 0.095 6.1E-03 6.1E-02 3.91 

Loam 0.463 0.027 0.27 0.117 3.7E-03 3.7E-02 4.17 
Silty Loam 0.501 0.015 0.3 0.133 1.9E-03 1.9E-02 4.20 
Sandy Clay 

Loam 
0.398 0.068 0.33 0.148 8.3E-04 8.3E-03 4.23 

Clay Loam 0.464 0.075 0.255 0.197 5.6E-04 5.6E-03 4.26 
Silty Clay 

Loam 
0.471 0.040 0.318 0.208 5.6E-04 5.6E-03 4.29 

Sandy Clay 0.430 0.109 0.366 0.239 3.3E-04 3.3E-03 4.32 
Silty Clay 0.479 0.056 0.339 0.250 2.8E-04 2.8E-03 4.35 

Clay 0.475 0.090 0.384 0.272 1.7E-04 1.7E-03 4.38 
* Rawls & Brakensiek Soil parameter estimates (1985). 
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3.4.1 Parameter entry 

The ‘Property’ window is opened by left-clicking on each source node. 

 
 

theta_per: This is the current moisture content of the soil. 0.25 is a default value and this value may 

change at each time step. It is a computated value between saturated moisture content ratios and residual 

moisture content ratios. 

soil_thick: This is the soil thickness generally in a range of 1 - 5. 

Saturate: This is the saturated soil moisture content ratio in a range of 0.4 - 0.6 (refer to Table 3.5). 

Residual: This is the residual soil moisture content ratio in a range of 0.02 - 0.2 (refer to Table 3.5). 

Field capacity: This is the soil moisture content at field capacity in a range of 0.1 - 0.5 (refer to Table 

3.5).  

Wilting point: This is the soil moisture content at wilting point in a range of 0.03 - 0.3 (refer to Table 

3.5).  

ks: This is the saturated hydraulic conductivity in a range of 0.1×10-4 - 0.7×10-1 (refer to Table 3.5). 

ksi: This is the horizontal hydraulic conductivity in a range of 0.1×10-3 - 0.7 (refer to Table 3.5). 

Mualem: When calculating vertical and horizontal infiltration, this model uses the Mualem equation, 

which utilizes unsaturated hydraulic conductivity. This shows the n (index) value of the Mualem equation, 

which is the input parameter. This value is in a range of 3 - 5 (refer to Table 3.5).  
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Inf_method : Selection for infiltration method, Rainfall Excess, Green & Ampt, Horton method are 

provided.  

 
 

PSI: Capillary suction head for Green & Ampt method. Table  3.6 shows the typical values of  PSI 

 

<Table  3.6> Typical value of PSI 

Soil type PSI (mm) 

Sand 49.5 
Loamy Sand 61.3 
Sandy Loam 110.1 

Loam 88.9 
Silt 130.7 

Silty Loam 166.8 
Sandy Clay Loam 218.5 

Clay Loam 208.8 
Silty Clay Loam 273.0 

Sandy Clay 239.0 
Silty Clay 292.2 

Clay 316.3 

* Rawls & Brakensiek Soil parameter estimates (1985) 
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k : decay constant for soil used by Horton method.  

fc : Minimum infiltration capacity for Horton method. See Table 3.6  

fo : Maximum infiltration capacity by Horton method. It affected by the type of soil, initial soil moisture 

and the surface condition. See Table 3.7  

 

 

<Table 3.6> Typical minimum infiltration capacity (fc) 

Soil drainage Classes Minimum Infiltration (fc) 
(mm/hr) 

A (Excessively drained) 11.43 ～ 7.62 
B (Well drained) 7.62 ～ 3.81 

C (Poorly drained) 3.81 ～ 1.27 
D (Very Poorly drained) 1.27 ～ 0.0 

* XP-SWMM User's Manual (2007)  

 

<Table 3.7> Typical maximum infiltration capacity (fo) 

Soil type 
Maximum Infiltration (fo)  

(mm/hr) 

A. Dry soils (with little or no vegetation) 

Sandy soil 127.0 
Loam soil 76.2 
Clay soil 25.4 

B. DRY soils (with dense vegetation) 

Sandy soil 254.0 
Loam soil 152.4 
Clay soil 50.8 

C. MOIST soils 

Soils which have drained but not dried out Sandy soil 84.7 

Soils close to saturation Loam soil 
Choose value close to minimum 

infiltration rate 
Soils which have partially dried out Clay soil 33.9 

* XP-SWMM User's Manual (2007) 
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3.5 River 
Since the parameters related to channels in the DWAT are closely related with groundwater aquifers, the 

model was designed to enter the parameters in the ‘Property View’ window. It is shown in the following 

figure. Channel specifications can be entered using the existing report or field survey. In this section, 

channel specification related variables will be explained and groundwater aquifer input parameters will be 

addressed in the next section.  

 

 

rivE: riverbed elevation 

Bed thick: riverbed material thickness (1.0 is a default value and this value is in a range of 0.1 - 1.0 

depending on river elevation) 

ku_riv: hydraulic conductivity of riverbed material (the range of 1.0×10-4 - 1.0×10-6   is generally used) 

Area: riverbed area 

 

3.6 Groundwater Aquifer 

In the DWAT, groundwater and river runoff are simulated using the relationship between groundwater 

and river levels. That is, if the groundwater level is higher than the river level, water will flow into the 

river depending on soil hydraulic conductivity. Conversely, if the river level is higher than the 

groundwater level, water will percolate into the aquifer. The model was designed to consider groundwater 

pumping and leakage from water supply networks. The leakage is simulated to flow into soil layer. In 

addition, moisture content movements between aquifers are considered. That is, level changes in 
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groundwater by moisture content movements between aquifers in each sub-catchment can be analyzed. 

As shown in the following figure, parameters related to aquifer specification may be entered under the 

‘Aquifer’ tab while comparing with channel specifications in order to determine the mutual relationship 

between groundwater and river levels. Each parameter will be reviewed in detail in the following section.  

3.6.1 Aquifer Specification Entry 

 

 

gwE: This indicates the initial groundwater level. This value will vary through the year if there is no 

initial groundwater level in each modeling period. Thus it is necessary to start the calculation from 

approximately one year before the analysis period in order to minimize the effect of uncertainty from the 

initial groundwater values during simulation. 

aqf_S: This indicates storage coefficient of aquifer. If there are records, a value in a range of 1.0×10-1 - 

1.0×10-2 is recommended. 

Top: The elevation of aquifer shall be determined by deducting the surface soil thickness from the 

ground surface elevation. 

Bottom: The bottom elevation of aquifer shall be determined by referring to existing examinations. 

When there are no field surveyed data, this value is generally assumed to be 20m ~ 30m below the top 

elevation of the aquifer. For existing records, groundwater survey reports for sub-catchment or field data 

can be used. 

Pumping: This indicates the groundwater pumping rate 

leakage: This indicates the leakage rate from water supply networks. 15% is generally recommended and 

0.15 is a default value. 
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3.6.2 Groundwater Movement Parameter Entry 

Parameters related to groundwater movement between adjacent sub-catchments are entered through a 

separated ‘Property View’. It is shown in the figure below.  

 

Connect: This is a window for selecting adjacent sub-catchment nodes to consider groundwater 

movement.  

 
 

Use_slope: This indicates groundwater hydraulic gradient. It can be obtained by calculation when the 

groundwater level is known for a catchment. However, if there is no information, it is generally 

recommended to use values smaller than ground surface slope. 

Node_length: This indicates a average distance between adjacent sub-catchments 

Conj._length: This indicates a conjuncted length between adjacent sub-catchments 

Kgw: This indicates hydraulic conductivity of aquifer. A value in a range of 1.0×10-4 ~ 1.0×10-6 is 

recommended. 
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3.7 Reservoir 
Ponds can be divided into two types: online and offline reservoirs. For offline reservoirs, the ratio of 

maximum inflows from the stream to the offline reservoirs to the mainstream discharge are predefined. It 

is used to calculate inflows into the offline reservoirs. Then, the mainstream discharge that will be a 

condition for discharge from the offline reservoirs to the mainstream is to be established in order to 

determine the outflow to downstream.[H2] Offline reservoirs are simulated[H3] to be emptied after a flood. 

In the case of online reservoirs, evaporation from water surface is considered. The reservoir storage, water 

level and discharge are calculated using the initial storage, effective storage, intake (here, water is taken 

only when the storage is at least 20% of the effective storage volume), the specifications of spillways and 

discharge outlet in the reservoir.  

Storage and water levels for both of the types are renewed by inflows based on the relationships of stage-

storage-area. 

The reservoir nodes are entered by selecting the ‘Reservoir’ icon and placing it in an appropriate 

position in the ‘Main Interface’ with clicking the left button on a mouse.  
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If the pond node is right-clicked, a window to set the parameters related to ponds will appear. 

 

Name: This indicates reservoir name. 

Descript: Information of the reservoir may be entered. 

Rainfall: rainfall station for the rainfall on the surface of reservoir. It uses the selected adjacent rainfall 

station.  
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Climate: climate station for evapotranspiration from the surface of reservoir. It uses the selected adjacent 

weather station.  

Type (Base tab): This is to select the type of the reservoir (online/offline). 

vol_init: Initial storage  

vol_eff: Effective storage  

Kgw: This indicates reservoir's bottom saturated hydraulic conductivity. This parameter is used to 

calculate the amount of loss in the bottom of reservoir. The value is in a range of 1.0×10-3 - 1.0×10-5. 

Recharge to: The loss from the bed of reservoir can be calculated by hydraulic conductivity (Kgw). If 

“Recaharge to” is selected, the recharged water can be transferred to catchment node to recharge 

groundwater. 

 
 

pipe_ht: Pond's outlet height 

pipe_area: Pond's outlet area 

pipe_coef: Pond's outlet runoff coefficients in a range of 0.5 - 1.0 

spill_ht: Height of spillway 

spill_length: Length of spillway 

spill_coef: Overflow coefficient of spillway in a range of 0.3 - 1.7 

Type (Intake tab): This is to select the type of the intake type (Constant/Time series). 
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Supply to: The intake from the reservoir can be transferred to selected node. To use this function the 

Recycle node must be located at the downstream of the reservoir node.. 

intake: This is intake volume from the reservoir. Water is taken only when the storage is at least 20% of 

the effective storage 

  

The online reservoir input parameters are described above. The following description is for offline 

reservoir input parameters. 

 

offline_max: This indicates maximum inflow into offline reservoirs. The streamflow discharge that does 

not flow into offline reservoirs is added to downstream links.  

offline_ratio:  This indicates ratio for inflow into offline reservoirs to the streamflow discharge.  

offline_out: This indicates the stream discharge as a condition for discharge into the river.  

 

 

 

As shown in the above Figure, the amount of storage and the storage water level relative to the amount of 

inflows are based on the relationships among water levels-storage amounts-areas.  
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3.8 Wetland 

The storage of wetlands was assumed to be the initial condition. It was also assumed that the excess flow 

is to be sent to the downstream node when inflow is larger than the high flow bypass during flood.  After 

calculating the volume of the remaining inflow, all of the volume will be overflowed when the volume is 

larger than the maximum storage. The module was designed to calculate water level, area, evaporation 

from the water surface and discharge through the outlet based on the final remaining storage volume.  

The wetlands node is entered by selecting the icon shown in the following figure, placing it on an 

appropriate position in the ‘Main Interface’ with clicking the left button on a mouse.  

 

If the wetland node is left-clicked, a window to set the parameters related to wetlands will appear.   
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Name: This indicates wetland name. 

Descript: Information of wetland overview may be entered. 

Rainfall: rainfall station for the rainfall on the surface of wetland. It uses the selected adjacent rainfall 

station.  

Climate: weather station for evapotranspiration from the surface of wetland. It uses the selected adjacent 

weather station.  

Init Volume: Initial storage  

Maximum storage: Maximum storage  

Flood_bypass: High flow bypass during flood 

Kgw: This indicates pond's bottom saturated hydraulic conductivity. This parameter is used to calculate 

the amount of loss in the bottom of ponds. The value is in a range of 1.0×10-3 - 1.0×10-5. 

Recharge to: The loss from the bed of wetland can be calculated by hydraulic conductivity (Kgw). If 

“Recaharge to” is selected, the recharged water can be transferred to catchment node to recharge 

groundwater. 
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pipe_height: Height of outlet pipe 

pipe_area: Area of outlet pipe 

pipe_coefficient: Runoff coefficient of outlet pipe in a range of 0.5 ~ 1.0 

 

Evaporation from water surfaces and the discharge in the wetland are calculated through a renewal of 

storage and water level of wetlands based on the stage-storage-area relationships. It is similar to the 

calculation process of reservoirs. 

 

3.9 Recycle 

In order to review the processes for designing recycle, the inflow is calculated and the daily used intake 

volume is then distributed to individual nodes. Water intake is restricted by defining intake restriction for 

intake rate determined by streamflow discharge rate.  

That is, if the value obtained by considering the inlet inflow amount and the intake restriction ratios is 

larger than the intake amount, the recycling inflow amount will be the same as the intake amount and the 
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amount of runoff to the toe will become the value obtained by deducting the intake amount from the inlet 

inflow amount. If the inlet inflow amount, considering the intake restriction ratios, is lesser than the 

intake amount, the recycling inflow amount will be the same as the inlet inflow amount considering the 

intake restriction ratios. The amount of runoff to the toe is the value obtained by deducting the intake 

amount from the inlet inflow amount.  

The Recycle node will be entered by selecting the icon shown in the following figure, placing it on an 

appropriate position in the ‘Main Interface’ with clicking the left button on a mouse.  

 

 

If the Recycle node is right-clicked, a window to set the parameters related to the Recycle will appear. 



67 

 

 

 

 

 

Name: This indicates Recycle node name. 

Descript: Information of Recycle node may be entered. 

Intake: Total intake volume  

rec_cond: Restriction for intake rate according to mainstream flow rate. The DWAT has a function to 

send the determined discharge to many catchment nodes (maximum five nodes) using Recycle.  

 

3.10 Import 

Parameters related to the water use from outside of catchments are used to design the Import fucntion. A 

constant amount on a daily basis is used, and time series data for water supply data can be loaded.  
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 The Import node may be entered by selecting the icon shown in the following figure, placing it on an 

appropriate position with clicking the left button on a mouse. 

 

If the Import node is left-clicked, a window to set the parameters related to the Import will appear. 
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Name: This indicates a node name 

Descript: Information of the node may be entered. 

Type: This is to select the type of data to be imported: ‘constant’ for a constant daily amount; ‘series 

data’ for time series data for water supply.  

Import water: This indicates imported water supply amounts. It is activated when the constant type is 

selected. 

Leakage  : Leakage from pipe network can be considered (The leaked water added to soil moisture in 

pervious area)  

Series file: This is to load the time series data for water supply. This is activated when the series data 

type is selected. A screen to choose the file appears and the data can be loaded by pressing ‘Time Series 

Data > Open’. The data file should be created using the ‘File > Create series’ menu as with the process to 

import meteorological data described in Section 3.2 (The ‘Type’ should be set as ‘User defined’). 

 

3.11 Channel Routing (Link) 

In the DWAT, the channel routing is a process to convert inflow hydrologic curves into runoff hydrologic 

curves in channel sections using the Muskingum, Muskingum-Cunge and Kinematic wave methods. In 

this section, the selections of methods of inputting data and routing methods in the Link are described in 

detail. 

 

If the Link that connects nodes together is left-clicked, a window to set the parameters for the Link will 

appear. 
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Name: This indicates a link name. 

Descript: Information of a link may be entered. 

Routing Methods: This is to set channel routing methods. ‘No routing’ is a default value and any 

channel routing methods can be chosen by the user.  

Muskingum: When the Muskingum method is selected. The user may enter various parameters to fit 

channel characteristics. 
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DT: Time interval 

X: Dimensionless constant in a range of 0.0 - 0.5 that indicates the relative importance of the inflow and 

runoff contributed to the total storage  

Y: Storage constant in the dimension of time (hour) that indicates the ratio of the storage to the runoff in 

the routing section 

 

Muskingum Cunge: The Muskingum Cunge method's attribute window appears and the user can enter 

each parameter to fit to channel characteristics. 

 

 

Channel length: Channel length 

Channel slope: Riverbed slope (dimensionless) 

Top width: Top width of channel 

Manning N: Manning’s roughness coefficient 

 

Kinematic wave: The Kinematic wave method's attribute window appears and the user can enter each 

parameter to fit channel characteristics. Computational demanding in running the model is required in the 

Kinematic wave method due to the effect of iteration for channel routing.  

 

Channel length: Channel section length 

Channel slope: Riverbed slope (dimensionless) 

Top width: Top width of channel 

Bottom width: Bottom width of channel 
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Manning N: Manning’s roughness coefficient 

Channel depth: Channel depth 

 

3.12 Junction and Outlet 

3.12.1 Junction 

The function of Junction in DWAT model have two aspect. The first one is a simple junction to combine 

the flow from upstream. The second one, combined sewer, is a unique in DWAT model. 

  The Junction node may be entered by selecting the icon shown in the following figure, placing it on 

an appropriate position in the ‘Main Interface’ with clicking the left button on a mouse.  

 

 

If the Import node is left-clicked, a window to set the parameters related to the junction will appear. 
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Name: Name of Junction 

Descript: Information of a junction may be entered. 

Connect: Select node to water transfer (for example, treatment plant), it is used for combined sewer 

networks. The flow less than specified rate can be moved to selected node. Water quality module will be 

added in next version.  

Maximum Q: The maximum flow rate to using Connect.  

 

3.12.2 Outlet 

The Outlet is a final exit of the system. Basically the Outlet node is similar to Junction except combined 

sewer function. The Outlet can be multiple. The Outlet node may be entered by selecting the icon shown 

in the following figure, placing it on an appropriate position in the ‘Main Interface’ with clicking the left 

button on a mouse. 
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If click the left mouse button, a window to set the parameters related to the outlet will appear. 

 

 

Name: Name of Outlet node 

Descript: Information of an outlet may be entered. 
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Chapter 4: Model Running 

 
If all input data have been completed, now you are ready to run the model. In the chapter, matters related 

to the model run will be explained. 

 

4.1 Analysis Condition Setting 

If the ‘Model’ menu is selected in the main menu, the ‘Model Setup’ menu for selecting analysis 

conditions and running the model will appear as follows: 

(교체) 

If the ‘Model’ menu is selected, a window for setting analysis conditions before running the model will 

appear as follows:  

  

Title: This indicates a simulation title. 

Term : A simulation period is needed to be selected. The total data period appears in the window and a 

user can define the simulation period. After clicking, the following date entry window will appear.  
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Interval: A user can revise a simulation time step for model run. The default unit is a second.  

4.2 Model Execution 

Once the analysis conditions have been set as above, the model is run by pressing ‘OK’ and selecting 

‘Run’ in the ‘Model’ menu. Now, the model is ready to run. When ‘Run’ is pressed, the model will be 

executed.  

 

 

Once ‘Complete execute model’ has appeared, press the ‘Close’ button.  
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Chapter 5: Analysis of Results 

 
If all the executions have been completed, now you are ready to analyze the result. The DWAT enables 

users to freely compare outputs at each node, junction and link including hydrologic components. This 

configuration is very helpful to users in analyzing the results.  

The DWAT basically has outputs of three types: water balance, graphs and tables. In this chapter, the 

methods to analyze the model results are explained in detail. The following Table 5.1 and Table 5.2 show 

summaries of the output parameters by source node that are created after executing the DWAT.  

 

Catchment node Description of output variables 

 

Inflow (㎥) inflow volume 

Rainfall (mm) rainfall 

Actual Evapotranspiration (mm) actual evapotranspiration 

Potential Evapotranspiration (mm) potential evapotranspiration 

Infiltrate (mm) Infiltration 

Soil moisture content (%) current soil moisture content 

Flow_surface (mm) surface runoff 

Flow_inter (mm) interflow 

Flow_groundwater (mm) groundwater runoff 

Recharge (mm) groundwater recharge 

Flow_total (mm) total runoff  

Groundwater Movement (mm) groundwater movement  

Groundwater Elevation (El. m) groundwater level elevation 

 

<Table 2.5-1> Output variables (catchment nodes) 
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Node Description of output variables 

Reservoir 

Inflow (㎥) inflow volume 

Downstream Outflow (㎥) mainstream discharge that did not flow into the 
pond 

Intake (㎥) intake volume 

Evaporation Water surface (mm) evaporation from water surface 

Spillway Outflow (㎥) overflow from spillway 

Pipe_Outflow (㎥) discharge from outlet pipe 

Aquifer Loss (㎥) loss from bottom of the pond 

Volume (㎥) storage volume 

Water Level (m) water level 

Wetland 

Inflow (㎥) inflow volume 

Bypass Volume (㎥) high flow bypass during flood season 

 Evaporation Water surface (mm) evaporation from water surface 

Spillway Outflow (㎥) overflow from spillway 

Pipe Outflow (㎥) discharge from outlet pipe 

Aquifer Loss (㎥) loss from bottom of the pond 

Volume (㎥) storage volume 

Water Level (m) water level 

Recycle 

Inflow (㎥) inflow volume 

Intake (㎥) intake volume 

Downstream Outflow (㎥) downstream discharge after intake 

water supply node name node name that receive supplied water 

Import Water Supply (㎥) water supply from outside 

 

<Table 2.5-2> Output variable (Other node) 
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5.1 Water Balance 

The results of water balance in a watershed may be viewed based on two methods. The first is to view the 

results in the main menu and it is shown in the following figure. The second is to view the results at each 

sub-catchment node in the catchment node configuration screen of the ‘Main Interface’. 

Pressing ‘Model’ > ‘Water-balance’ menu in the main menu. 

  

 

 

By year: This is a tab to control output formats. Analysis results are displayed on an annual basis. As 

shown in the above figure, each hydrologic component is displayed on the left side and water balance is 

displayed by node on the right side along with average value. 

By node: This is a tab to control output formats. Analysis results are displayed by sub-catchment. As 

shown in the following figure, each hydrologic component is displayed on the left side and resultant 

values are displayed on the right side on an annual basis.  
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Select: This is to select the outlets of a catchment. If the catchment has many outlets, the results on the 

water balance may be identified for each catchment outlet.  

 

In the second method for viewing water balance results, water balance may be viewed by right-

clicking on each sub-catchment node as mentioned above. However, the water balance output from sub-

catchment nodes does not provide information on the entire water balance, but rather provides only the 

resultant water balance of the relevant sub-catchment. Right-clicking on the sub-catchment node and 

clicking the ‘Water balance’ menu. 

  

The following window will appear.  
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Year: The relevant year may be selected. As shown in the above figure, the water balance results at 

hydrologic component may be identified by clicking each relevant year.  

5.2 Chart 

Analysis results are shown in various forms of graphs in the DWAT. As with the above water balance 

results, there are two methods to view graphic results on the entire catchments. Graphic results for 

individual sub-catchments, links, junctions and outlets can be viewed by the setting tab of the left window, 

no matter which method the user selects to view the results. The method to check results in the main 

menu is as follows:  

- Select ‘Model’ > ‘Chart’ in the main menu.  

- Right-clicking on the sub-catchment node and clicking the ‘Chart’ menu. 
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A Chart result window will appear. 

  

: This is a project selection window. In ’Current’, the results of the current project 

may be viewed. When the plus button is selected, the results of other projects are opened and displayed 

for comparison. That is, a function to compare the result of the current project with those of other projects 

is provided.  

 : This attribute window shows the information of each node, junction, link and outlet of 

the relevant project. 

 : This is located below the node attribute window and shows the field attribute window. 

They are the output parameters mentioned earlier in Tables 5.1 and 5.2. The user can select the relevant 
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sub-catchment or the link and junction through the node attribute window and then select output variables 

in the field attribute window to see graphic results. 

The user may press the ‘Add’ button to display the graphic results when the sub-catchment and output 

variable have been selected. It is shown in the following figure.  

 

  : The left bottom window displays the names of the 

currently output variables. The user may also select multiple nodes and output variables and display them 

simultaneously on the same screen. If the user wishes to delete some output items from the graph, the user 

may click on the item or right- click the button and select ’Remove‘. If the user wishes to delete all items, 

the user may just select the ‘init’ button. In addition, the interested region in the graph may be expanded 

by using the dragging function of the mouse.  Once expanded, the region may be moved using the scroll 

bar on the bottom of the graphic result. The user can go back to the entire view by pressing the ‘Zoom 
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All’ button. The form of an expended graph is as shown in the following figure. 

  

5.3 Table 

The DWAT contains a function to view result values in the form of tables at all nodes, junctions, links 

and outlets. 

Unlike water balance and graphic results, table results can be viewed only through right mouse clicks on 

the nodes, links and junctions of the main screen. In addition, information on all nodes cannot be seen, 

and only the results for individual node are outputted. That is, the result field of tables is the output 

parameter and each output parameter is as shown in Tables 5.1 and 5.2.  

The following window appears by right-clicking on a node in the configuration screen of the main 

interface.  

  

When the ‘Table’ menu has been selected, the following table result window is displayed. As shown in 

the figure, the names of the output variable for each time series appear on the top and time series data are 

displayed.   
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